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Chapter 1: About This Document

1.1 What’s in this document?

This document contains the following types of information:

• Information about the changes in LiveCycle ES3 that may affect your upgrade planning and an overview of how the 

upgrade process works, including an outline of the tasks involved

• All the tasks that must be performed to ensure that the upgrade runs correctly with minimal server downtime 

(including backing up the existing LiveCycle server and patching the application server as required)

• All hardware and software requirements and configurations that must be already in place to ensure a successful 

LiveCycle ES3 upgrade process

Note: If you are planning to perform an upgrade by using the turnkey method for JBoss, you do not need to perform 

many of the steps in this document. It is recommended that you review the section “Understanding the Changes in 

LiveCycle ES3” on page 6. However, all preparatory information for a turnkey upgrade, including system 

requirements, is included in Upgrading to Adobe LiveCycle ES3 for JBoss Turnkey.

After you complete the tasks in this document, proceed to the Upgrading to Adobe LiveCycle ES3 document for 

your application server.

1.2 Who should read this document?

This document provides information for administrators or developers who are responsible for preparing the 

application and database servers for development, staging, and production environments prior to installing, 

configuring, upgrading, administering, and deploying LiveCycle ES3. 

The information provided is based on the assumption that anyone reading this document is familiar with application 

servers, operating systems, database servers, and web environments.

1.3 Conventions used in this document

This document uses the following naming conventions for common file paths. 

http://www.adobe.com/go/learn_lc_upgrade_turnkey_10
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Most of the information about directory locations in this document is cross-platform (all file names and paths are case-

sensitive on Linux and UNIX®). Platform-specific information is indicated as required.

1.4 Additional information

The resources in this table can help you learn about LiveCycle ES3.

Name Description Default value

[LiveCycle root] The installation directory used for all LiveCycle modules. 

The directory contains subdirectories for LiveCycle ES3 - 

Configuration Manager, SDK, and licensed modules 

(along with the product documentation). This directory 

also includes directories that relate to third-party 

technologies. 

Windows: 

C:\Adobe\Adobe LiveCycle ES3

Linux and UNIX: 

opt/adobe/adobe_livecycle_es3/

[appserver root] The home directory of the application server that runs 

the services that are part of LiveCycle ES3. 

JBoss on Windows: C:\jboss\

JBoss on Linux: /opt/jboss/

WebSphere on Windows: C:\Program 

Files\IBM\WebSphere\AppServer\ 

WebSphere on Linux and UNIX: 

/opt/IBM/WebSphere/AppServer/

WebSphere on AIX: /usr/IBM/WebSphere/AppServer/

or

/opt/IBM/WebSphere/AppServer/

WebLogic Server 11g on Windows: 

C:\Oracle\Middleware\wlserver_10.3\

WebLogic Server 11g on Linux and Solaris: 

/opt/Oracle/Middleware/wlserver_10.3/ 

[appserverdomain] The domain that you configured on WebLogic 

application server.

WebLogic Server on Windows: 

C:\Oracle\Middleware\user_projects\domains\base_dom

ain 

WebLogic Server on Linux and UNIX: 

/opt/Oracle/Middleware/user_projects/domains/base_do

main

For information about See

Performing the upgrade from LiveCycle ES Update 1 or LiveCycle ES2 

to LiveCycle ES3 using the turnkey method

Upgrading to LiveCycle ES3 for JBoss Turnkey

Upgrading from LiveCycle ES Update 1 or LiveCycle ES2 for JBoss, 

WebSphere, and WebLogic servers

Upgrading to LiveCycle ES3

General information about LiveCycle ES3 and the modules LiveCycle ES3 Overview

Other services and products that integrate with LiveCycle ES3 Adobe Developer Connection

LiveCycle modules LiveCycle Modules

http://www.adobe.com/go/learn_lc_upgrade_turnkey_10
http://www.adobe.com/go/learn_lc_upgrade_10
http://www.adobe.com/go/learn_lc_overview_10
http://www.adobe.com/devnet.html
http://www.adobe.com/LiveCycle
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All documentation that is available for LiveCycle ES3 LiveCycle ES3 documentation

LiveCycle ES3 release information and last-minute changes that 

occur to the product

LiveCycle ES3 Release Notes

Patch updates, technical notes, and additional information about 

this product version

Adobe® Enterprise Support

For information about See

http://www.adobe.com/go/learn_lc_documentation_10
http://www.adobe.com/go/learn_lc_releaseNotes_10
http://www.adobe.com/go/learn_lc_support


4

Last updated 7/12/2013

Chapter 2: Introduction to Upgrading to 
LiveCycle ES3

This section provides information about the documentation that is available to help you understand the upgrade 

process. It also provides a high-level outline of the tasks that are involved in upgrading LiveCycle ES Update 1 or 

LiveCycle ES2 to LiveCycle ES3. 

Before you read this document, ensure that you have read the Upgrade Checklist and Planning guide.

2.1 Upgrading to LiveCycle ES3 from 8.x

The documents Upgrading to LiveCycle ES3 for JBoss, Upgrading to LiveCycle ES3 for WebSphere, and Upgrading to 

LiveCycle ES3 for WebLogic provide the information that you need to perform the actual installation and migration 

steps that make up the upgrade process. Each guide is specific to the application server you are using.

2.1.1 Upgrading to LiveCycle ES3 for JBoss Turnkey

The Upgrading to LiveCycle ES3 for JBoss Turnkey from 8.x document includes all the steps that are required to 

upgrade to LiveCycle ES3 for JBoss and MySQL from LiveCycle ES (8.x) by using the turnkey method. The turnkey 

method installs, configures, and upgrades the product. 

You can upgrade using the turnkey method if you installed LiveCycle ES (8.x) by using JBoss turnkey and if the 

modules are deployed to the JBoss instance that was included as part of the turnkey installation.

Note: The LiveCycle ES3 turnkey option runs on JBoss 4.2.1 only. The LiveCycle ES3 installation will install and 

configure this product. Your existing JBoss 4.0.3 SP1 server instance can be removed once you have verified that your 

upgraded environment is working.

Perform this type of upgrade to rapidly get a LiveCycle ES3 system up and running for small-scale production, 

demonstration, evaluation, development, or training purposes. The turnkey method installs and configures a default 

set of Adobe and third-party products that provide a functioning LiveCycle ES3 environment.

Note: To perform an upgrade by using the turnkey method, you do not need to perform many of the steps in this document 

(Preparing for Upgrading to LiveCycle ES3). It is recommended that you review the section “Understanding the Changes 

in LiveCycle ES3” on page 6 . However, all preparatory information for turnkey upgrades, including system requirements, 

are included in Upgrading to LiveCycle ES3 for JBoss Turnkey.

You can also upgrade using the turnkey method if your LiveCycle ES3 system will reside on a different computer. In 

this case, however, you will need to configure your database and global document storage (GDS) directory separately. 

The major tasks involved are:

• Manually copy the GDS directory to the new computer.

• Manually copy the lccs_data directory to the new computer or on a shared network drive.

• Manually restore your database backup to the new computer.

• Provide the details of the new GDS directory and database during configuration.

Note: While upgrading to LiveCycle ES3 using turnkey method, you must specify the same database credentials as for 

your LiveCycle ES 8.x turnkey installation.

http://www.adobe.com/go/learn_lc_upgrade_checklist_10
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2.1.2 Upgrading a LiveCycle ES 8.2 WebLogic Turnkey

There is no support for WebLogic turnkey in LiveCycle ES3. If you have an existing LiveCycle ES 8.2 WebLogic 

turnkey and need to upgrade, you must perform an out-of-place upgrade as described in the following pages and in 

the Upgrading to LiveCycle ES3 for WebLogic guide.

2.1.3 Configuration Manager Help

Part of the upgrade is completed by using Configuration Manager, a wizard-like tool that leads you through the 

upgrade process, prompting you to provide the required information. On each Configuration Manager screen, you can 

press the F1 key to view the Help dialog box for that screen.

For more information about Configuration Manager, see the Upgrading to LiveCycle ES3 document for your 

application server, mentioned earlier in this section.

2.2 Upgrading task outline

This section outlines the tasks that are involved in the upgrade process, from the planning stage to the post-

deployment stage. 

To upgrade from LiveCycle ES Update 1 or LiveCycle ES2 to LiveCycle ES3, you must complete the following tasks. 

Task See

Understand the upgrade process (high-level section). “Understanding the Changes in LiveCycle ES3” on page 6

Read the Upgrade Checklist and Planning guide Upgrade Checklist and Planning

Run the Enterprise Readiness Tool and check how ready is your 

software infrastructure to run LiveCycle ES3.

“3.3 Enterprise Readiness Tool” on page 6

(In-place) Reuse or patch the existing application server instance to 

ensure that you have the supported version.

(Out-of-place) Install the appropriate operating system and 

application server versions.

“System Requirements” on page 14

Ensure that you have all the information about passwords, directory 

locations, and credentials that you need.

“4.3 Gathering required information before you start” on page 9

Back up all existing data, resources, directories. Upgrade Checklist and Planning guide

Install LiveCycle ES3. Upgrading to LiveCycle ES3 for your application server 

Run Configuration Manager to upgrade to and configure LiveCycle 

ES3.
• Upgrading to LiveCycle ES3 for your application server

• Configuration Manager Help (Press F1 on the Configuration Manager 

screen)

http://www.adobe.com/go/learn_lc_upgrade_checklist_10
http://www.adobe.com/go/learn_lc_upgrade_checklist_10
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Chapter 3: Understanding the Changes in 
LiveCycle ES3

To successfully upgrade to LiveCycle ES3 from LiveCycle ES Update 1 or LiveCycle ES2, you must first understand 

which parts of your IT organization are involved. This section provides the high-level information that is required to 

plan for your upgrade. 

3.1 How the LiveCycle ES3 upgrade protects your IT 
investment

The upgrade to LiveCycle ES3 is designed to provide an automated experience with minimal manual tasks. It continues 

to protect your investment in the forms, processes, and applications that you have built around LiveCycle. By 

protecting that investment, an IT administrator can upgrade to LiveCycle ES3 without help from the form authors who 

created your forms, the process authors who created your processes, and the Java™ developers who created custom 

applications for LiveCycle ES Update 1 or LiveCycle ES2. 

The LiveCycle ES3 upgrade limits the changes so that they affect only the middle tier of your enterprise infrastructure. 

For example, if you are using Adobe Reader®, your organization can continue to use the existing version of Adobe 

Reader that you deployed across your clients. Keeping the LiveCycle ES3 upgrade restricted to your middle tier 

minimizes the disruption to the remainder of your enterprise infrastructure.

3.2 Adobe Reader compatibility

One of the key features of the upgrade is that the version of Adobe Reader on the client is independent of the version 

of LiveCycle ES3 on the server. When LiveCycle ES3 renders a form, it renders it in the version of PDF that you specify. 

You can create forms that work best in Adobe Reader 8.x or Adobe Reader 9.x, or you can use new features that work 

best with Adobe Reader X. Form authors are warned if they choose to use a feature that is not appropriate for the 

particular version of Adobe Reader. 

All forms render in LiveCycle ES3 in the same way they rendered in previous versions. All the scripts that you added 

to your forms will work in LiveCycle ES3. In addition to the LiveCycle ES3 features that support multiple versions of 

Adobe Reader, Adobe Reader itself also works with multiple versions of LiveCycle ES3. You can roll out Adobe Reader 

X to your clients without upgrading your server. 

3.3 Enterprise Readiness Tool

The Enterprise Readiness Tool (ERT) automatically examines the preparedness of your software infrastructure to 

install or upgrade to LiveCycle ES3. Software infrastructure signifies the application server, operating system, JDK, 

database, and other supporting software required to install and run LiveCycle ES3. ERT validates the version of all 

supporting software against supported platform combinations for LiveCycle ES3. ERT also detects presence of 

unsupported runtime components and services when validating the target environment for upgrade readiness.
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The ERT report that is generated when you run the tool helps you assess the readiness of your software infrastructure 

and provides you with the ability to plan the next course of action. For more information, see Using the Enterprise 

Readiness Tool.

3.4 Overview of the upgrade process

Upgrading from LiveCycle ES Update 1 or LiveCycle ES2 to LiveCycle ES3 installs LiveCycle ES3 software that is 

subsequently configured using settings from the existing LiveCycle server. Configuration settings, user data, and job 

information are migrated to the LiveCycle ES3 system. 

Most of the tasks in the upgrade process are automated and performed (with some user input) by Configuration 

Manager. Configuration Manager is a tool used to configure, deploy, and validate LiveCycle ES3 components for 

deployment to the application server. When run in upgrade mode, Configuration Manager also performs upgrade 

specific tasks such as updating configuration settings and data.

The GDS directory, Content Storage Root directory (if applicable), and database must be accessible to Configuration 

Manager during the upgrade process.

You can continue to use your existing database if it is a version that is compatible with LiveCycle ES3. If your current 

database version is no longer supported, back up the data and restore it to a compatible version.

If you are not changing major application server version and are performing an in-place upgrade, your existing 

application server must be running to deploy the new EAR files. For all other upgrades, the old application server does 

not need to run during the process. For more information on in-place or out-of-place upgrades, see “5.2 In-place or 

Out-of-place upgrades” on page 14

3.4.1 Upgrading to LiveCycle ES3 using Configuration Manager

Upgrading to LiveCycle ES3 modules from LiveCycle ES Update 1 or LiveCycle ES2 involves these tasks:

1 Installing LiveCycle ES3 product files. 

2 Running Configuration Manager to initiate the configuration, upgrading, and deployment process. The remaining 

steps (below) are included in this process.

3 Updating and deploying LiveCycle ES3 EAR files to the application server.

Note: For an in-place upgrade, you must manually undeploy the existing LiveCycle EAR files from the application 

server.

4 Starting LiveCycle ES3 on the application server, so that it is available to accept user requests. This is done 

automatically after the EAR files are deployed. However, you must start the server manually if it does not start 

automatically.

5 Initializing the LiveCycle ES3 database so that LiveCycle ES3 specific schema changes are incorporated in the 

database without affecting the existing data.

Note: This step is mandatory and must not be skipped during an upgrade. It does not affect existing data in any way.

6 Patching existing LiveCycle ES3 components with new versions and deploying new LiveCycle ES3 components, if any.

7 Migrating to the database, essential data, as well as all remaining data, such as audit records that are submitted or 

historical data that are associated with LiveCycle Process Management. 

http://www.adobe.com/go/learn_lc_readiness_tool_10
http://www.adobe.com/go/learn_lc_readiness_tool_10
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3.5 Updating client libraries

JBoss Application Server 

If your custom applications use JAR files (client-libs) that are specific to JBoss, you must ensure that the JBoss-specific 

client-lib files are also updated within the custom applications to avoid seeing any issues while using them. 

The JBoss client libraries are located in the client directory in third party/jboss.zip on the LiveCycle ES3 

installation media (DVD or ESD).

WebLogic Server

For WebLogic, include the full WebLogic client JAR file (wlfullclient.jar) in the classpath of the custom application. If 

your client applications run on version 5 of the JDK, they use a different JAR file. You must build the full WebLogic 

client JAR file manually. Follow the steps in the article Programming Stand-alone Clients to generate the full 

WebLogic client JAR file.

General Issues

If your custom applications use the LiveCycle ES Update 1 adobe-livecycle-client.jar file, after upgrade, you may 

see an exception in your application server logs while using custom applications. The exception may look similar to:

 java.io.FileNotFoundException: Response: '403: Forbidden' for url: 
'http://localhost:8080/DocumentManager'

To avoid these errors when running your custom applications, do one of the following tasks (the first task is the 

preferred method):

• Replace the adobe-livecycle-client.jar file used in your custom application with the LiveCycle ES3 adobe-livecycle-

client.jar file located in [LiveCycle root]/sdk/client-libs/common

• Log in to Administration Console and click Settings > Core System Settings > Configurations. Select the options 

Allow non secured document upload from Flex applications and Allow non secured document upload from 

Java SDK applications, click OK and restart your application server.

3.6 Upgrading the Connectors for ECM

Upgrading connectors is supported in all scenarios. However, the steps are different, depending on support for the 

server version of your connector, in LiveCycle ES3. Upgrading connectors for ECM is supported:

• If your current ECM server is a version supported in LiveCycle ES3, you can upgrade without any issues.

• If your current ECM server is an unsupported version, run the LiveCycle ES3 upgrade first, skipping the Form 

Template Import step. Once LiveCycle is upgraded to LiveCycle ES3 and configured, you can then upgrade your 

ECM server to a supported version and rerun Configuration Manager to import the form templates. Install the new 

ECM client and then configure your applications to work with the client.

Note: If the ECM content server is upgraded before Connector for IBM FileNet or Connector for EMC Documentum is 

upgraded to LiveCycle ES3, run-time configuration information for LiveCycle, such as shared locks on the resources, will 

not be available and migrated to LiveCycle ES3. 

See the appropriate section in “5.3 System requirements” on page 17 to verify supported ECM versions.

http://docs.oracle.com/cd/E21764_01/web.1111/e13717/jarbuilder.htm
http://docs.oracle.com/cd/E21764_01/web.1111/e13717/jarbuilder.htm
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Chapter 4: Preparing Your Environment 
for Upgrading

Before you begin the upgrade process, you must perform several tasks to prepare your environment for upgrading:

• Run the Enterprise Readiness Tool (ERT) on your current LiveCycle ES Update 1 or LiveCycle ES2 installation. See 

Using the Enterprise Readiness Tool for more information.

• Read the Upgrade Checklist and Planning guide and complete all the verification tasks and validation checks on 

your existing LiveCycle ES Update 1 or LiveCycle ES2 environment.

• Based on the findings of the Upgrade Checklist/ERT, update any QPAC-based workflows to DSC-based workflows 

either using the Workbench (versions 8.2.1, 9.0, or 9.5 as applicable) Process Upgrade Tool OR manually writing 

DSC/Service operations for the same. 

• Refer to the platform matrix, and prepare the software infrastructure required for the upgrade. Complete any 

manual steps before upgrading your LiveCycle instance. For example, if a new application server is required, refer 

to the relevant sections of 'Preparing to Install LiveCycle ES3' guide to prepare the new application server instance. 

Apply the latest patches to your application server, as required in the LiveCycle ES3 Supported Platform 

Combinations document. Or, if a new version of Database server is required then, data from older Database server 

instance must be migrated to the newer Database server instance.

• Back up the existing LiveCycle environment.

4.1 The LiveCycle ES3 upgrade execution workflow

An upgrade workflow consists of a set of tasks that must be completed to ensure a successful upgrade from your 

current LiveCycle installation to LiveCycle ES3. For information on this task set, see Upgrade Workflow.

4.2 Upgrading your infrastructure

Some platforms that were supported in the erstwhile versions of LiveCycle continue to be supported in LiveCycle ES3. 

However, there is support for some new platforms too. For example, LiveCycle ES3 supports more recent versions of 

application servers, and you may need to apply the latest patches to your application server.

Note: When an existing application server is supported, it is recommended that you apply the latest patches and ensure 

that the updated application server is running correctly before you upgrade to LiveCycle ES3.

For details about supported platforms, see LiveCycle ES3 Supported Platform Combinations.

4.3 Gathering required information before you start

This section serves as a checklist for the information that you need during the upgrade process. During the upgrade, 

you will be instructed or prompted to provide this information. If you ensure that it is available before you begin, you 

can speed up the process and minimize any server downtime. 

http://www.adobe.com/go/learn_lc_readiness_tool_10
http://www.adobe.com/go/learn_lc_upgrade_checklist_10
www.adobe.com/go/learn_lc_supportedplatforms_10
www.adobe.com/go/learn_lc_supportedplatforms_10
http://help.adobe.com/en_US/livecycle/10.0/UpgradeChecklist/WS714a69d55f7d60aa10934b68130919f1e3e-8000.html
www.adobe.com/go/learn_lc_supportedplatforms_10
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4.3.1 Determining important ports

Note the JNDI port number for your application server (JBoss, WebLogic, or WebSphere) and listener port for your 

database instance, which you plan to use for upgrading to LiveCycle ES3.

If you are not sure which ports the database uses, contact your database administrator.

4.3.1.1 JBoss:

1 Navigate to the correct directory: 

• If you are using JBoss 4.2.1 when upgrading to LiveCycle ES3, navigate to the right folder:

• If using JBoss Turnkey, navigate to the [appserver root]/server/lc_turnkey/conf directory

• If using Adobe pre-configured JBoss, navigate to the [appserver root]/server/lc_<database type>/conf 

directory

• If using JBoss downloaded from internet, navigate to the [appserver root]/server/all/conf directory

• If you are using JBoss 5.1 when upgrading to LiveCycle ES3, navigate to the right folder:

• If using JBoss Turnkey, navigate to the [appserver root]/server/lc_turnkey/conf directory

• If using Adobe pre-configured JBoss, navigate to the [appserver root]/server/lc_<database type>/conf 

directory

• If using JBoss downloaded from internet, navigate to the [appserver root]/server/standard/conf directory

2 Open the jboss-service.xml file.

3 Find the <mbean code="org.jboss.naming.NamingService"> element. The JNDI server port is the value of the 

<attribute name="Port"> element. 

4.3.1.2 WebSphere

1 Log in to the WebSphere Administrative Console.

2 In the navigation tree, click Servers > Server Types > WebSphere application servers. 

3 On the right pane, click the server name.

4 Under Communications, click Ports, and find the value of BOOTSTRAP_ADDRESS.

4.3.1.3 WebLogic

For WebLogic, the JNDI server port is usually the same as the http port for the server that is created to host LiveCycle 

ES3. If a Managed Server is configured for deployment of LiveCycle ES3, the JNDI port should be same as the http port 

used by the Managed Server. 

4.3.2 Server names

If you are performing a staged installation of LiveCycle ES3 product files, and running Configuration Manager from 

a different computer than the target server, you must know the hostname of the system that LiveCycle ES3 will be 

deployed on.
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4.4 Export and backup Business Activity Monitoring 
metadata

Note: Do not perform the procedure described in this section if you wish to continue using BAM and the old BAM 

database with LiveCycle ES3. If you wish to use a new database for BAM with LiveCycle ES3, perform the procedure and 

reinstall BAM using LiveCycle ES or LiveCycle ES2 installation media after upgrading to LiveCycle ES3.

This task is required only if you wish to reuse an existing Business Activity Monitoring installation. 

Before you begin, export the metadata so that the customized BAM objects are available to be imported into LiveCycle 

ES3. This applies customized objects only - do not export auto-generated objects. If you installed BAM Server 

manually, you must uninstall it manually as well.

4.4.1 Export the BAM Server metadata

1 In a browser, type http://[hostname]:[BAM port]/bam/workbench and log in to BAM Workbench.

2 Click Application Workbench > Event.

3 Select all events except for VC_SYSTEM_EVENTS, VC_TASK_EVENTS and your customized events.

4 Click Delete Event(s) and then click Delete Dependencies when prompted.

5 Delete all views except for VC_SYSTEM_VIEW, VC_TASK_VIEW and your customized views.

6 Click Delete View(s) and then click Delete Dependencies when prompted.

7 Repeat steps 5 and 6 for Contexts, Dimensions and Cubes, substituting the appropriate VC_SYSTEM_<>, 

VC_TASK_<> objects.

8 Delete all JAR files except for your customized JAR files. Click Delete This Jar... and then click Delete 

Dependencies when prompted.

9 Click the Administration Console tab and click Import/Export.

10 When prompted, choose Export Metadata to a JAR file on the server, enter the server location and click OK. 

Note: Save the exported JAR file to a location available to the LiveCycle ES2 installer.

11 Stop the application server and delete the 3 tables in BAM metadata database.

4.5 Uninstalling the BAM Server manually

Note: LiveCycle ES3 is the last release to support BAM. If you wish to continue using BAM with LiveCycle ES3, skip this 

section. If you do not wish to continue using BAM, it is recommended that you uninstall it by performing the steps 

described in the section below.

When you uninstall your existing LiveCycle installation, BAM will be removed along with it. Because some folders 

might not be removed during uninstallation, you should ensure that BAM has been cleanly uninstalled before you 

attempt to reinstall BAM.

Important: If you wish to continue using BAM with LiveCycle ES3, do not perform the steps below.

Uninstall BAM Server:

1 Stop BAM Server. 
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2 Undeploy the BAM Server EAR file by doing one of the following:

• (JBoss only) Removing Lava_Adobe.ear from [bam root]/server/<profile_name>/deploy directory.

• (WebLogic only) Undeploy and delete the old BAM Server EAR file using WebLogic Server Administration 

Console

• (WebSphere only) Undeploy the BAM Server EAR file using WebSphere Administrative Console.

3 (JBoss only) Remove the following files:

• [bam root]/server/<profile_name>/log/*

4 Delete all the files from the recovery log directory and logging directory that have names similar to the following 

patterns:

• filestore*.dat

• DEFAULTRECOVERYLOGGER_*

• chkpoint*

5 Review the contents of the [bam root]\bin folder and, if any chkpoint* files exist, delete them.

6 Use your database management tools to drop the database tables that store the BAM Server metadata.

• UNCOMMITTED_TID

• ALLOCATED_UID

• METADATA_OBJECTS

4.6 Running LiveCycle in maintenance mode

Maintenance mode is useful when performing tasks such as patching a DSC, upgrading LiveCycle, or applying a 

service pack.

4.6.1 Put LiveCycle in maintenance mode

Note: Applicable only if you are upgrading from LiveCycle ES2.

In a web browser, enter: 

http://[hostname]:[port]/dsc/servlet/DSCStartupServlet?maintenanceMode=pause&user=[administr

ator_username]&password=[password]

A "now paused" message is displayed in the browser window.

Note: If you shut down the server while it is maintenance mode, it will still be in maintenance mode when it is restarted. 

You must turn off maintenance mode when you are finished your maintenance tasks.

4.6.2 Check whether LiveCycle is running in maintenance mode

In a web browser, enter:

http://[hostname]:[port]/dsc/servlet/DSCStartupServlet?maintenanceMode=isPaused&user=[admini

strator_username]&password=[password]

The status is displayed in the browser window. A status of "true" indicates that the server is running in maintenance 

mode, and "false" indicates that the server is not in maintenance mode.
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Note: Returns "true" only if you had put the LiveCycle ES2 system in maintenance mode.

4.7 Stop Scheduler Service

Note: Applicable only if you are upgrading from LiveCycle ES Update 1.

1 Before starting the upgrade, log in to Workbench ES Update 1 and click Window > Show View > Components

2 Scroll to the SchedulerService, right click on it and select Stop Component.

3 Log out of Workbench ES Update 1.
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Chapter 5: System Requirements

5.1 Prepare your server environment

Do the following tasks to prepare your server environment:

1 Verify that the installation media is not damaged. It is recommended that you copy the installer files to the hard 

disk of the computer where you intend to install LiveCycle, instead of installing directly from the installation media. 

Also verify the MD5 checksum of the installation media matches the checksum posted at Adobe Website.

2 Read “5.3 System requirements” on page 17, and ensure that your software infrastructure is compliant.

3 Read System requirements, and ensure that your hardware infrastructure is in place, as per your requirements.

4 Install the operating system and update with all necessary patches and service packs.

5 Install and configure the database server.

6 Install and configure the application server.

7 Ensure that your target computer has at least the required amount of RAM as described in “5.3.1 Minimum 

hardware requirements” on page 17.

5.2 In-place or Out-of-place upgrades

In-place upgrades: If you are upgrading a WebSphere 7.0 system, apply the latest Fix Packs from IBM. If you are 

upgrading a JBoss 4.2.1 system, it can be used as is with some modifications.

Out-of-place upgrades: If you are performing an out-of-place upgrade, prepare the application server according to 

the instructions in the Preparing to Install LiveCycle document. 

When you are ready to upgrade to LiveCycle, refer to the following document for instructions on performing the 

upgrade:

• Upgrading to LiveCycle for JBoss

• Upgrading to LiveCycle for WebLogic

• Upgrading to LiveCycle for WebSphere

• Upgrading to LiveCycle for JBoss Turnkey

5.2.1 Supported LiveCycle platforms for in-place upgrade

The ability to perform an in-place upgrade to LiveCycle depends on the version of LiveCycle you are upgrading from.

5.2.1.1 Upgrading from LiveCycle ES Update 1

If you are upgrading from LiveCycle ES Update 1, you cannot perform an in-place upgrade. To upgrade to LiveCycle, 

you must perform an out-of-place upgrade.

5.2.1.2 Upgrading from LiveCycle ES2

If LiveCycle ES2 is installed in an environment described in the table below, you can perform an in-place upgrade:

http://www.adobe.com/support/adobe_digital_enterprise_platform/trial/md5_checksum.html
http://www.adobe.com/go/learn_lc_upgrade_jboss_10
http://www.adobe.com/go/learn_lc_upgrade_weblogic_10
http://www.adobe.com/go/learn_lc_upgrade_websphere_10
http://www.adobe.com/go/learn_lc_upgrade_turnkey_10
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5.2.1.3 Upgrading from LiveCycle ES2 SP2

If LiveCycle ES2 SP2 is installed in an environment described in the table below, you can perform an in-place upgrade:

Operating System App Server Database Hardware

AIX 6.1 WebSphere 7.0.0.5 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

AIX 6.1 WebSphere 7.0.0.5 Oracle 11g / 10g 64 OS / 64 JVM

RedHat EL Server & AP 5.0 JBoss 4.2.1 Oracle 11g / 10g 64 OS / 64 JVM

RedHat EL Server & AP 5.0 JBoss 4.2.1 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

RedHat EL Server & AP 5.0 WebSphere 7.0.0.5 Oracle 11g / 10g 64 OS / 64 JVM

RedHat EL Server & AP 5.0 WebSphere 7.0.0.5 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

Solaris 10 JBoss 4.2.1 Oracle 11g / 10g 64 OS / 64 JVM

Solaris 10 JBoss 4.2.1 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

Solaris 10 WebSphere 7.0.0.5 Oracle 11g / 10g 64 OS / 64 JVM

Solaris 10 WebSphere 7.0.0.5 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

SUSE 10 JBoss 4.2.1 Oracle 11g / 10g 64 OS / 64 JVM

SUSE 10 JBoss 4.2.1 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

JBoss 4.2.1 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

JBoss 4.2.1 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

JBoss 4.2.1 MS SQL Server 2005 SP2 / 

2008

64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

WebSphere 7.0.0.5 MS SQL Server 2005 SP2 / 

2008

64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

WebSphere 7.0.0.5 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

WebSphere 7.0.0.5 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

Windows Svr 2008 JBoss 4.2.1 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

Windows Svr 2008 JBoss 4.2.1 MS SQL Server 2005 SP2 / 

2008

64 OS / 64 JVM

Windows Svr 2008 JBoss 4.2.1 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2008 WebSphere 7.0.0.5 MS SQL Server 2005 SP2 / 

2008

64 OS / 64 JVM

Windows Svr 2008 WebSphere 7.0.0.5 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2008 WebSphere 7.0.0.5 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM
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Operating System App Server Database Hardware

AIX 6.1 WebSphere 7.0.0.9 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

AIX 6.1 WebSphere 7.0.0.9 Oracle 11g / 10g 64 OS / 64 JVM

RedHat EL Server & AP 5.0 JBoss 4.2.1/EAP 4.3 Oracle 11g / 10g 64 OS / 64 JVM

RedHat EL Server & AP 5.0 JBoss 4.2.1/EAP 4.3 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

RedHat EL Server & AP 5.0 WebSphere 7.0.0.9 Oracle 11g / 10g 64 OS / 64 JVM

RedHat EL Server & AP 5.0 WebSphere 7.0.0.9 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

RedHat EL Server & AP 5.0 WebLogic 11gR1 - 10.3.3 Oracle 11g / 10g 64 OS / 64 JVM

Solaris 10 JBoss 4.2.1/EAP 4.3 Oracle 11g / 10g 64 OS / 64 JVM

Solaris 10 JBoss 4.2.1/EAP 4.3 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

Solaris 10 WebSphere 7.0.0.9 Oracle 11g / 10g 64 OS / 64 JVM

Solaris 10 WebSphere 7.0.0.9 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

Solaris 10 WebLogic 11gR1 - 10.3.3 Oracle 11g / 10g 64 OS / 64 JVM

SUSE 10 JBoss 4.2.1/EAP 4.3 Oracle 11g / 10g 64 OS / 64 JVM

SUSE 10 JBoss 4.2.1/EAP 4.3 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

SUSE 11 JBoss 4.2.1/EAP 4.3 Oracle 11g / 10g 64 OS / 64 JVM

SUSE 11 JBoss 4.2.1/EAP 4.3 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

SUSE 11 WebSphere 7.0.0.9 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

SUSE 11 WebSphere 7.0.0.9 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

JBoss 4.2.1/EAP 4.3 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

JBoss 4.2.1/EAP 4.3 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

JBoss 4.2.1/EAP 4.3 MS SQL Server 2005 SP2 / 

2008

64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

WebSphere 7.0.0.9 MS SQL Server 2005 SP2 / 

2008

64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

WebSphere 7.0.0.9 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2003 SP2 & R2 

SP2

WebSphere 7.0.0.9 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

Windows Svr 2008 JBoss 4.2.1/EAP 4.3 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2008 R1/R2 JBoss 4.2.1/EAP 4.3 MS SQL Server 2005 SP2 / 

2008

64 OS / 64 JVM

Windows Svr 2008 R1/R2 JBoss 4.2.1/EAP 4.3 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

Windows Svr 2008 R1/R2 WebSphere 7.0.0.9 MS SQL Server 2005 SP2 / 

2008

64 OS / 64 JVM
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5.3 System requirements

5.3.1 Minimum hardware requirements

This table provides the minimum hardware requirements that LiveCycle supports.

Windows Svr 2008 R1/R2 WebSphere 7.0.0.9 Oracle 11g / 10g 64 OS / 64 JVM

Windows Svr 2008 R1/R2 WebSphere 7.0.0.9 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

Windows Svr 2008 R2 WebLogic 11gR1 - 10.3.3 MySQL 5.0.18 / 5.1.30 64 OS / 64 JVM

Windows Svr 2008 R2 WebLogic 11gR1 - 10.3.3 DB2 9.1 and later 9.x 

updates

64 OS / 64 JVM

Windows Svr 2008 R2 WebLogic 11gR1 - 10.3.3 MS SQL Server 2005 SP3 / 

2008 

64 OS / 64 JVM

Windows Svr 2008 R2 WebLogic 11gR1 - 10.3.3 Oracle 11g / 10g 64 OS / 64 JVM

Operating system Minimum hardware requirement

Microsoft Windows Server® 2008 R1/R2 (64-

bit architecture)

Intel® Pentium® 4, 2.8 GHz processor or equivalent

VMWare ESX 3.0 or later

RAM: 4 GB (64-bit OS with 64-bit JVM)

Free disk space: 5.4 GB of temporary space plus 3.4 GB for LiveCycle 

Microsoft Windows Server® 2003 Enterprise 

Edition or Standard Edition SP2 and R2 SP2 

(64-bit architecture)

Intel® Pentium® 4, 2.8 GHz processor or equivalent

VMWare ESX 3.0 or later

RAM: 4 GB (64-bit OS with 64-bit JVM)

Free disk space: 5.4 GB of temporary space plus 3.4 GB for LiveCycle

Sun Solaris 10 (64-bit architecture) UltraSPARC® IIIi, 1.5 GHz processor

Solaris Containers (Zones) partitioning

RAM: 4 GB (64-bit OS with 64-bit JVM)

Free disk space: 5.4 GB of temporary space plus 3.4 GB for LiveCycle

Operating System App Server Database Hardware
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5.3.1.1 Intel x86 compatibility

On supported Windows and UNIX -like environments, LiveCycle supports Intel and AMD64 compatible chipsets 

running either 32-bit or 64-bit supported operating systems.

Note: 32-bit platforms are supported only for development and evaluation purposes.

5.3.1.2 Recommended hardware requirements

For a small production environment:

Intel environments: Pentium 4, 2.8 GHz or greater. Using a dual core processor will further enhance performance.

Sun SPARC environments: UltraSPARC V or later.

IBM AIX environments: Power4 or later

Memory requirements: 4 GB of RAM.

5.3.1.3 Additional hardware requirement for Adobe LiveCycle Content Services 
(deprecated)

If you are installing Content Services for use with a DB2 database, you must have a minimum of 2 GB of RAM on the 

computer hosting the DB2 database.

5.3.1.4 Recommended hardware requirements for client-side computers

Adobe® LiveCycle® Workbench 10

• Disk space for installation: 

1.5 GB for Workbench only

1.7 GB on a single drive for a full installation of Workbench, Adobe® LiveCycle® Designer 10, and the samples 

assembly

400 MB for temporary install directories - 200 MB in the user temp directory and 200 MB in the Windows 

temporary directory 

IBM AIX 6.1 P5 pSeries 520 (Model 52A) 9131-52A, 1.8 GHz processor

LPAR partitioning

RAM: 4 GB (64-bit OS with 64-bit JVM)

Free disk space: 5.4 GB of temporary space plus 3.4 GB for LiveCycle

SUSE Linux Enterprise Server 10.0 and 11.0 

(64-bit edition only)

Dual core, 1 GHz processor

VMWare ESX 3.0 or later 

RAM: 4 GB (64-bit OS with 64-bit JVM)

Free disk space: 5.4 GB of temporary space plus 3.4 GB for LiveCycle 

Red Hat Enterprise Linux AP or ES 5.5 (64-bit 

edition only)

Dual core, 1 GHz processor

VMWare ESX 3.0 or later 

RAM: 4 GB (64-bit OS with 64-bit JVM)

Free disk space: 5.4 GB of temporary space plus 3.4 GB for LiveCycle

Operating system Minimum hardware requirement
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Note: If all of these locations reside on a single drive, there must be 1.5 GB of space available during installation. The 

files copied to the temporary directories are deleted when installation is complete.

• Memory for running Workbench: 2 GB of RAM

• Hardware requirement: Intel® Pentium® 4 or AMD equivalent, 1 GHz processor

• Minimum 1024 X 768 pixels or greater monitor resolution with 16-bit color or higher

• TCP/IPv4 or TCP/IPv6 network connection to the LiveCycle server

Note: You must have Administrative privileges to install Workbench on Windows. If you are installing using a non-

administrator account, the installer will prompt you for the credentials for an appropriate account.

Designer 

• Adobe® Reader® X and Adobe® Acrobat® X Pro (recommended) is required to benefit from all the new features in 

Designer. 

• Adobe® Flash® Player 10.2 or later.

• (Optional) Adobe® Flash® Builder® 4.5 or later.

• (Optional) Adobe® Flex® SDK 4.1 (required for customizing form guide components that are shipped with 

Designer).

Note: Use the Flex SDK 4.1 included with the Designer installer only. Do not use any other version of Flex SDK obtained 

from the Adobe web site.

Note: For more information, see Installing Your Development Environment.

End-user hardware requirements:

• Adobe® LiveCycle® Workspace 10: 1 GB of RAM (includes requirements for Adobe Flash and Adobe Reader)

• Adobe Flash Player 9 or later: 512 MB of RAM (1 GB recommended)

• Adobe Reader 8.x or later: 128 MB of RAM (256 MB recommended)

Note: For web browser requirements, see LiveCycle Supported Platform Combinations.

5.3.2 Supported Platforms

For detailed information about the supported combinations of operating systems, application server, databases, JDKs, 

and so on, see LiveCycle Supported Platform Combinations.

5.3.3 Additional requirements for AIX, Linux, and Solaris 

Note: On AIX, Linux and Solaris machines, the LiveCycle installer uses the JDK installed on the machine. Therefore, you 

must ensure to install the supported JDK version. On other operating systems, the installer uses the JVM bundled with 

the installer. 

5.3.3.1 Installing and configuring UTF-8

When installing LiveCycle on AIX, Linux, or Solaris operating systems, you must install and configure the US English 

version of UTF-8 locale if it is not already installed. You will need the install media (CDs or DVDs) for the operating 

system to perform this task.

Note: On Linux platforms, this locale is installed by default and is called en_US.utf8. It can be verified by using the 

locale -a command.

http://www.adobe.com/go/learn_lc_workbench_10
www.adobe.com/go/learn_lc_supportedplatforms_10
http://www.adobe.com/go/learn_lc_supportedplatforms_10
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Installing UTF-8 on AIX

1 Verify the US English UTF-8 locale is not installed by typing locale -a in a command prompt. Verify that the 

command output does not contain the entry EN_US.UTF-8.

2 Access the AIX SMIT utility (in text mode) by typing smitty mle_add_lang at the root in the command prompt.

3 On the screen that appears, select UTF-8 US English (United States) [EN_US] from both the CULTURAL 

CONVENTION and LANGUAGE TRANSLATION drop-down lists.

Note: Keep the INPUT DEVICE/DIRECTORY as the default /dev/cd0 setting.

4 Press Enter to proceed. A message such as the following will appear:

installp: Device /dev/cd0 not ready for operation.  
Please insert media and press Enter to continue.

5 Insert the appropriate AIX install disk in the disk drive.

6 When the command is complete, exit the SMIT utility and type locale -a to verify that EN_US.UTF-8 is set as 

the locale.

Installing UTF-8 on Solaris

1 Verify the US English UTF-8 locale is not installed by typing locale -a in a command prompt. Verify that the 

command output does not contain the entry EN_US.UTF-8.

2 Insert the Solaris install CD #1 in the disk drive and mount it to an appropriate location, for example:

/cdrom/sol_10_807_sparc/s0

3 Type the following command as root: localeadm -a nam -d /cdrom/sol_10_807_sparc/s0

Note: This command installs all locales in the North America (nam) region even if you specify only the en_US.UTF-

8 locale.

4 When the command is complete, type locale -a to verify that EN_US.UTF-8 is set as the locale.

Note: See this link for FAQs on Solaris Locales.

5.3.3.2 Solaris

Note: Ensure that X Window libraries are installed on your operating system. This is required for Adobe® LiveCycle® PDF 

Generator 10 and Adobe® LiveCycle® Forms 10. See the documentation for your operating system for more information.

Important: Do not use the Solaris tar command to extract files or errors (such as missing files) will occur. Download the 

GNU tar tool and use it to extract all files on a Solaris environment.

5.3.3.3 Linux

On Linux operating systems, ensure the following:

• All Linux distributions: Ensure that X Window libraries are installed on your operating system. This is required 

for PDF Generator and Forms. See documentation for your operating system for more information.

• SUSE Linux: You must install the glibc-locale-32bit library that ships with SUSE Linux Enterprise Server; 

otherwise, LiveCycle will not generate PDF files. This library file is not installed by default, you must use YaST to 

install it. (See the SUSE Linux Enterprise Server documentation for details.) 

If you plan to install LiveCycle on SUSE Linux 11, you must also install the libstdc++- libc6.2-2.so.3 libraries. SUSE 

Linux 11 does not include these libraries by default. For more information, see this Novell Web page. These libraries 

are required for running Adobe Central Pro Output Server

http://developers.sun.com/dev/gadc/faq/locale.html
http://www.novell.com/documentation/suse.html
http://www.novell.com/products/linuxpackages/desktop11/x86_64/compat-32bit.html
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5.3.3.4 Configuring the file limit values on Solaris and Linux

To avoid StuckThread issues on a Solaris or Linux environment, add or increase the rlim values in the /etc/system file.

1 (Linux) Locate and open the /etc/security/limits.conf file.

(Solaris) Locate and open the /etc/system file.

2 (Linux) Add the following lines to the /etc/security/limits.conf file:

<app_group> soft nofile 8192  
<app_group> hard nofile 8192

Replace <app_group> with the user group who will run the application server. You may also replace <app_group> 

with an asterisk (*) to match all users and user groups. 

(Solaris) Locate and modify the rlim values in the /etc/system file as follows:

set rlim_fd_cur: The initial (soft) maximum number of file descriptors per process. Set this value to 8192 or 

more. 

set rlim_fd_max: The hard maximum number of file descriptors per process. Set this value to 8192 or more. 

(This modification is required only if the default value is lower than 8192). You must have super user privileges to 

change this value.

Note: The rlim_fd_max value must be equal to or greater than the rlim_fd_cur value.

3 Save and close the file.

4 Restart your computer.

Verify the updated settings

1 Launch a new shell.

2 Type ulimit -n and press Enter.

3 Verify the value returned matches the rlim values you have set.

5.3.4 Privileges required to install on Windows

When installing on Windows, you must use an account that has administrator privileges. If you run the installer using 

a non-administrator account, enter the credentials of an account that has administrator privileges. 

5.3.5 Configuring Windows installation

On 64-bit Windows Server 2008 R1, Windows Server 2008 R2 or Vista operating systems, modify the Admin Approval 

Mode security option as follows:

1 (On Windows 2008 R1 and Vista) Go to Start > Control Panel > Administrative Tools > Local Security Policy > 

Local Policies > Security Options.

(On Windows 2008 R2 and Windows 7) Go to Start > Administrative Tools > Local Security Policy > Local 

Policies > Security Options.

2 Locate User Account Control: Behavior of the elevation prompt for administrators in Admin Approval Mode 

and set it to Elevate without prompting.

3 Restart your computer.
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5.3.5.1 Disable the Windows UAC on Vista and Windows Server 2008 R1

1 To access the System Configuration Utility, go to Start > Run and then enter MSCONFIG.

2 Click the Tools tab and scroll down and select Disable UAC. 

3 Click Launch to run the command in a new window. 

4 When finished, close the command window and close the System Configuration window.

5 Restart your computer.

To enable the UAC again, repeat the steps above and select Enable UAC before clicking Launch.

5.3.5.2 Disable the Windows UAC on Windows Server 2008 R2 and Windows 7

1 To access the System Configuration Utility, go to Start > Run and then enter MSCONFIG.

2 Click the Tools tab and scroll down and select Change UAC Settings.

3 Click Launch to run the command in a new window.

4 Adjust the slider to the Never notify level.

5 When finished, close the command window and close the System Configuration window.

6 Restart your computer.

To enable the UAC again, repeat the steps above and adjust the slider to a desired level before restarting your 

computer.

Important: The Windows User Account Control (UAC) must remain disabled for PDF Generator to work properly. You 

can run the installation and configuration process by turning on the UAC with the Elevate without prompting option 

enabled. However, disable UAC to run PDF Generator.
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5.3.6 Minimum database user permissions

5.3.7 Additional requirements for PDF Generator

Note: You cannot use the Shared Printer Protocol for the SendToPrinter API on Windows 2008 machines that have 

PDF Generator deployed on them. Use alternate protocols like CIFS or Direct IP.

5.3.7.1 User account for Windows

You must use a user account with administrator privileges for the following tasks: 

• Installing Microsoft Office

• Installing PDF Generator

Database Initialization permissions Runtime permissions

Oracle CREATE SESSION

CREATE CLUSTER

CREATE TABLE

CREATE VIEW

CREATE SEQUENCE

UNLIMITED TABLE SPACE

CREATE SESSION

UNLIMITED TABLE SPACE (only needed if 

you do not configure user quotas)

CREATE TABLE

MySQL SELECT

INSERT

UPDATE

DELETE

CREATE

DROP

REFERENCES

INDEX

ALTER

CREATE_TEMP_TABLE

LOCK_TABLES

SELECT

INSERT

UPDATE

DELETE

SQL Server - DB level Create Table

Create View

Connect

Connect

SQL Server - Schema level Alter

Insert

References

Select

Update

Delete

Insert

Select

Update

Delete

DB2 See DB2 user account for complete 

description.

See DB2 user account for complete 

description.
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• Installing Acrobat for PDF Generator 

• Running the application server process

5.3.7.2 Using 64-bit application servers with PDF Generator

If you are using a 64-bit application server on a system with PDF Generator, ensure that a 32-bit Java 6 JDK is installed 

in addition to the 64-bit one the application server uses. Set the environment variable JAVA_HOME_32. This variable is 

required to point to a 32-bit JDK on systems where a 64-bit application server is in use. The specific path varies based 

on the installation directory you specified and the operating system you are installing on.

Note: You need to install the 32-bit Sun JDK and configure JAVA_HOME_32 to point to the directory where it resides. 

Review Sun Java 6 Release Notes > Supported System Configurations and download the 32-bit version for your operating 

system. However, if you are using AIX, do not set JAVA_HOME_32.

Important: Ensure that JAVA_HOME_32 is set only as an environment variable and is not included in the PATH. If 

JAVA_HOME_32 is included in the PATH, Java core dumps may appear during EAR deployment or when you restart the 

server.

5.3.7.2.1 Set the Windows JAVA_HOME_32 variable

1 Select Start > Control Panel > System. 

2 Click the Advanced tab.

3 Click Environment Variables and, under System Variables, click New.

4 Enter the environment variable JAVA_HOME_32. This value is the directory that contains the JDK. For example, type 

the following:

D:\Program Files (x86)\Java\jdk1.6.0_26

5.3.7.2.2 Set the JAVA_HOME_32 variable on Linux or Solaris

Set the JAVA_HOME_32 variable for the supported JDK for Bourne and Bash shells as shown in this example:

JAVA_HOME_32=/opt/jdk1.6.0_26  
export JAVA_HOME_32

5.3.7.3 Native file conversion software installation

Before you install PDF Generator, install the software that supports the file formats for which PDF conversion support 

is required and manually activate the licenses for the software using the user account that is used for running the 

application server process.

Refer to the individual licensing agreement for each native application that your LiveCycle deployment will support, 

and ensure that your LiveCycle deployment meets the licensing requirements specified. Typically, each LiveCycle user 

who will use native application support must also have an activated license on their own computer for the native 

application.

PDF Generator can be extended to convert these additional file types to PDF files by using the following applications: 

Note: PDF Generator supports only English, French, German, and Japanese versions of the supported applications.

• Microsoft Office 2007, 2010 (DOC,DOCX XLS,XLSX PPT,PPTX, RTF, TXT, Microsoft Office open XML Formats)

• Microsoft Office Visio 2007, 2010 (VSD)

• Microsoft Publisher 2007, 2010 (PUB)

• Microsoft Project 2007, 2010 (MPP)
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• AutoCAD 2008 and 2009 (DWG, DWF) 

Note: LiveCycle supports only 32-bit editions of all the above mentioned software. 

Note: Native file conversions using AutoCAD for DWG, DXF, and DWF files are supported only on 32-bit environments. 

Conversions for these file types using Acrobat are supported on both 32-bit and 64-bit platforms.

• Corel WordPerfect 12, X4 (WPD)

• Adobe Photoshop® CS3

• Adobe FrameMaker® 7.2, 8.0 (FM)

• Adobe PageMaker® 7.0 (PMD, PM6, P65, PM)

• OpenOffice 3.3 (ODT, ODP, ODS, ODG, ODF, SXW, SXI, SXC, SXD, SXM)

Note: OpenOffice 3.3 or later must be installed on the server to convert the documents created in version 3.3. 

Note: On Linux platform, OpenOffice must be installed under /root user. If OpenOffice is installed for specific users, 

PDFG might not be able to convert OpenOffice documents. 

You do not need to install a native software application to convert the following native file formats:

• Print files (PS, PRN, EPS)

• Web files (HTML)

• Image files (JPEG, GIF, BMP, TIFF, PNG)

5.3.7.4 Installing Acrobat for PDF Generator

Install Acrobat X before running the LiveCycle installer. Ensure that you launch Acrobat at least once after installing 

it to avoid PDF Generator configuration issues. Dismiss all modal dialog boxes that appear on launching Acrobat. 

Note: Ensure that Acrobat is installed using the same user account that you will use to install LiveCycle.

However, if LiveCycle is installed and Acrobat X is not installed, install Acrobat X and then run the 

Acrobat_for_PDFG_Configuration.bat script, located in the folder [LiveCycle root]\pdfg_config. Otherwise, PDF 

conversions may fail.

The Configuration Manager sets the Acrobat_PATH (case-sensitive) environment variable automatically. You can 

also choose to set it manually, see “5.3.7.7 Setting environment variables” on page 26. Restart your application server 

after setting the environment variable.

Note: Depending on the JDK that you use, download the required JAR files from either Sun or IBM website.

5.3.7.5 Configure Acrobat to use SHX fonts (Windows only)

Note: Perform these steps to configure Acrobat if you want PDF Generator to use SHX fonts to convert AutoCAD DWG 

files without installing AutoCAD. Also, these steps need to be performed for all user accounts configured in 

Administration Console.

1 Open Acrobat.

2 Select Edit > Configurations.

3 Select Convert to PDF > Autodesk AutoCAD.

4 Click Edit Settings.

5 Click Configuration Preferences.

6 Click Browse next to the SHX Font File Search Path and specify the path to the SHX font file.
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7 Click OK on each opened dialog.

5.3.7.6 QuickTime 7

PDF Generator requires that QuickTime 7 (Player or Pro) be installed if you want to convert video embedded in files, 

such as PowerPoint presentations to PDF multimedia files. This application is available from the Apple Downloads site.

5.3.7.7 Setting environment variables

You must set the environment variables in Windows if you plan to create PDF documents from applications such as 

FrameMaker, Photoshop, PageMaker, and WordPerfect. 

The names of these environment variables are listed here:

• FrameMaker_PATH

• Notepad_PATH (This should be left blank)

• OpenOffice_PATH

• PageMaker_PATH

• Photoshop_PATH

• WordPerfect_PATH

• Acrobat_PATH

These environment variables are optional and need to be set only if you plan to use the corresponding application to 

convert PDF files through PDF Generator. The value of the environment variable should contain the absolute path of 

the executable that is used to start the corresponding application. 

For example, the variable FrameMaker_PATH may contain the value C:\Program Files\Adobe\ 

FrameMaker7.2\FrameMaker.exe. However, OpenOffice_PATH is different from others. This variable must be set to 

the OpenOffice installation folder (instead of the path to the executable). A typical value of OpenOffice_PATH on 

Windows would be C:\Program Files (x86)\OpenOffice.org 3\.

Paths for Microsoft Office applications such as Word, PowerPoint, Excel, Visio, and Project or for AutoCAD are not 

required. The Generate PDF service starts these applications automatically if they are installed on the server.

 To set the Windows environment variables

1 Select Start > Control Panel > System. 

2 Click the Advanced tab.

3 Click Environment Variables and, under System Variables, click New.

4 Enter the environment variable name you need to set (for example, FrameMaker_PATH). This value is the directory 

that contains the executable file. For example, type the following:

C:\Program Files\Adobe\FrameMaker7.2\FrameMaker.exe

5.3.7.8 Service Control Manager command line tool

Before you complete an automatic installation of PDF Generator on Windows, ensure that the Service Control 

Manager command line tool, sc.exe, is installed in the Windows environment. Some Windows servers do not have this 

software preinstalled. By default, the sc.exe file is installed in the C:\Windows\system32 directory. Most OS 

installations have this tool installed. If you do not have the tool installed, it is available in the Windows Resource Kit 

for your specific version of Windows. To confirm that the tool is installed on your server, type sc.exe from a 

command prompt. The tools usage is returned.
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5.3.7.9 Headless mode configuration

If you are running PDF Generator in a headless mode environment (that is, on a server without a monitor, keyboard, 

or mouse), the x11 libraries must be installed. Some flavors of Linux do not install these libraries by default; therefore, 

you must obtain the libraries and install them manually.

Note: Activating x11 forwarding on a shell session causes the SOAP UI to create UI elements during SOAP requests, 

leading to request failures. To avoid request failures, you must add the -Djava.awt.headless=true JVM argument.

5.3.7.10 Enabling multi-threaded file conversions and multi-user support for PDF Generator

By default, PDF Generator can convert only one OpenOffice, Microsoft Word, or PowerPoint document at a time. If 

you enable multi-threaded conversions, PDF Generator can convert more than one of the documents concurrently by 

launching multiple instances of OpenOffice or PDFMaker (which is used to perform the Word and PowerPoint 

conversions). 

Note:  Multi-threaded file conversions are not supported with Microsoft Word 2003 and PowerPoint 2003. In addition, 

Microsoft Excel (2003, 2007 and 2010 versions) is not supported. To enable multi-threaded file conversions, upgrade to 

Microsoft Word 2007 or 2010 and PowerPoint 2007 or 2010. 

Note: Microsoft Excel and Microsoft Visio files are not converted simultaneously. During conversion, EXCEL.exe and 

VISIO.exe are watched in the task manager. The Visio file is processed only after processing on the Excel file is complete.

Each instance of OpenOffice or PDFMaker is launched using a separate user account. Each user account that you add 

must be a valid user with administrative privileges on the LiveCycle Server computer. On 64-bit Windows, disable 

Windows UAC. For more information, see “5.3.5 Configuring Windows installation” on page 21

After your LiveCycle Server is configured, add LiveCycle user accounts in Administration Console. See the User 

accounts for multi-threaded file conversions section in the LiveCycle installation guide for your application server. To 

enable multiuser support for native files and OpenOffice files on a Windows environment, add a minimum of three 

users with the following permissions. 

When you add users for PDF Generator native conversions, grant the user running the application server with the 

Replace a process level token privilege.For more information, see “5.3.7.12 Granting the Replace a process level token 

privilege (Windows only)” on page 29

Dismiss initial dialogs and automatic updates for native applications

Converting native files from PDF Generator requires dismissing any initial registration, activation, and Improvement 

program dialogs with the option to not show them again. Automatic updates for these applications also needs to be 

disabled as these update dialogs can cause failures on a running server.

The dialogs and automatic update need to be disabled for the user running the server and all user accounts configured 

under PDFG Accounts for multi-user support. The dialogs need to be dismissed for the following applications if 

installed on the server:

• Microsoft Word (Windows)

• Microsoft Excel (Windows)

• Microsoft PowerPoint (Windows)

• Microsoft Project (Windows)

• Microsoft Publisher (Windows)

• Microsoft Visio (Windows)

• OpenOffice (Windows/ Solaris / Linux)

• Adobe Acrobat (Windows)
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• Adobe Photoshop (Windows)

• Adobe FrameMaker (Windows)

• Adobe PageMaker (Windows)

• Autodesk AutoCAD (Windows)

• Corel WordPerfect (Windows)

Disable error reporting on Windows Server 2003 or 2008 (Optional but recommended)

While converting a document to PDF using PDF Generator on Windows Server 2003 or 2008, Windows may report 

that the executable has encoutered a problem and needs to close. However, it does not impact the PDF conversion as 

it continues in the background.

To avoid receiving the error, you can disable the Windows error reporting. For more information on disabling error 

reporting, see the following articles:

• Windows Server 2003 - http://technet.microsoft.com/en-us/query/cc773392

• Windows Server 2008 - http://technet.microsoft.com/en-us/library/cc754364.aspx

Additional configuration required for OpenOffice on Linux or Solaris

1 Add entries for additional users (other than the administrator who runs the LiveCycle Server) in the /etc/sudoers 

file. For example, if you are running LiveCycle as a user named lcadm and a server named myhost, and you want 

to impersonate user1 and user2, add the following entries to /etc/sudoers:

lcadm myhost=(user1) NOPASSWD: ALL

lcadm myhost=(user2) NOPASSWD: ALL

This configuration enables lcadm to run any command on host ‘myhost’ as ‘user1’ or ‘user2’ without prompting for 

password.

2 Allow all the LiveCycle users to make connections to the LiveCycle Server. For example, to allow a local user named 

user1 the permission of making the connection to the LiveCycle Server, use the following command:

xhost +local:user1@

For more details, refer to xhost command documentation.

3 Restart the server.

5.3.7.11 Multi-user support for PDF Generator

To enable multi-user support for native files and OpenOffice files on a Windows environment, a minimum of three 

users with the following permissions must be added. On a AIX, Linux, or Solaris platform, create at least one user.

When you add users for PDF Generator native conversions, you must grant the user running the application server 

with the Replace a process level token privilege. See “5.3.7.12 Granting the Replace a process level token privilege 

(Windows only)” on page 29.

Platform User permissions

Windows 2008 Server Users with administrative privileges, UAC 

disabled and with replace a process level token 

privilege

Windows 2003 Server Users with administrative privileges

AIX, Linux, and Solaris Users with sudo privileges

http://technet.microsoft.com/en-us/query/cc773392
http://technet.microsoft.com/en-us/library/cc754364.aspx
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5.3.7.12 Granting the Replace a process level token privilege (Windows only)

User accounts that are used to start the application server from a command prompt and not as a Windows service 

requires the Replace a process level token privilege. This setting is required for PDF Generator.

1 Click Start > Run, and then type gpedit.msc.

2 On the Group Policy dialog box, select Computer Configuration > Windows Settings > Security Settings > Local 

Policies > User Rights Assignment, and double click Replace a process level token.

3 Click Add User or Group, add the Windows user account that is used to open the command prompt from which 

the application server is started.

4 Restart Windows, and then start the application server.

5.3.8 Additional requirements for Connector for Documentum

If LiveCycle is connecting to Documentum, you must install Document Foundation Classes on machine hosting 

LiveCycle. 

5.3.9 Additional requirements for Connector for IBM Content Manager

Note: For upgrade, these configurations are only required if you do not have Adobe® LiveCycle®10 Connector for IBM® 

Content Manager installed on your existing LiveCycle installation but will license it on LiveCycle or if you are performing 

an out-of-place upgrade on a new operating system.

Connector for IBM Content Manager requires the following software installed (both available from the IBM website):

• DB2 Universal Database Client

• IBM Information Integrator for Content (II4C)

See “Post-Deployment Activities” chapter in the Upgrading LiveCycle document for your application server.

5.3.9.1 Configure the connection for a single IBM Content Manager datastore

1 Start the DB2 Configuration Assistant.

2 Click Selected > Add Database Using Wizard.

3 Select Manually Configure a Connection to a Database and click Next.

4 Select TCP/IP and click Next.

5 Specify the following TCP/IP communication options and then click Next:

• In the Host Name box, type the host name of the server hosting DB2 Content Manager.

• Leave the Service Name box empty.

• In the Port Number box, type the port number. The default DB2 Content Manager port number is 50000.

6 In the Database Name box, type the IBM Content Manager datastore name and, in the Database Alias box, type 

the alias name for the datastore and then click Next.

7 Click Next to accept the default data source settings.

8 In the Operating System list, select the operating system you are using and then click Next.

9 Specify the following system options and then click Next:

• In the System Name box, type the server name hosting DB2. If you click Discover, DB2 Content Manager 

searches for the system name you specified and, if the system is not found, all of the DB2 instances are listed.
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• In the Host Name box, type the name of the host, or click View Details to show the domain and IP address of 

the system you named in the previous step.

• In the Operating System list, select the operating system (Windows, Linux, or AIX) on which you deployed DB2 

Content Manager.

10 (Optional) To specify Security options, select Use Authentication Value in Server’s DBM Configuration and click 

Finish.

11 In the Test Connection dialog box, test the connection as required.

5.3.9.2 Configure connections for multiple IBM Content Manager datastores

1 Configure the initial connection by following the steps in “5.3.9.1 Configure the connection for a single IBM 

Content Manager datastore” on page 29.

2 Add additional database connections by modifying the cmbicmsrvs.ini file (the file that stores the datastore 

information) as follows:

• From a command prompt window, change the directory to [II4C home]/bin (for example, C:\Program 

Files\db2cmv8\ on Windows or /opt/IBM/db2cmv8 on AIX, Linux, or Solaris). 

• Run the cmbenv81.bat (Windows) or cmbenv81.sh (AIX, Linux, or Solaris) file to set the environment and the 

classpath for the Java Utilities of II4C.

• Change the directory to [II4C working directory]/cmgmt/connectors where [II4C working directory] is one of the 

following paths:

(Windows) C:/Program Files/db2cmv8

(Linux, AIX) /home/ibmcmadm

(Solaris) /export/home/ibmcmadm

• Run the command

java com.ibm.mm.sdk.util.cmbsrvsicm -a add -s <library server database name> -sm <database 
schema name>

where <library server database name> is the same as Database Alias configured in step 6 above.

Note: The following procedure allows users without DB2 rights to share the connection credentials through the 

cmbicmenv.ini file. 

5.3.9.3 Configure a multiuser connection to the IBM Content Manager datastore

1 From a command prompt window, change the directory to [II4C home]/bin (for example, C:\Program 

Files\db2cmv8\ on Windows or /opt/IBM/db2cmv8 on AIX, Linux, or Solaris). 

2 Run the cmbenv81.bat (Windows) or cmbenv81.sh (AIX, Linux, or Solaris) file to set the environment and the 

classpath for the Java Utilities of II4C.

3 Change the directory to [II4C working directory]/cmgmt/connectors, where [II4C working directory] is one of the 

following paths:

(Windows) C:/Program Files/db2cmv8

(Linux, AIX) /home/ibmcmadm

(Solaris) /export/home/ibmcmadm

4 Run the command
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java com.ibm.mm.sdk.util.cmbenvicm -a add -s <library server database name> -u <database 
user ID> -p <database password>

where <library server database name> is the same as Database alias configured in step 6 above.

5.3.10 Additional requirements for Connector for IBM FileNet

These requirements are optional and required only if you are installing Adobe® LiveCycle® 10 Connector for IBM® 

FileNet. 

Note: For upgrade, these configurations are only required if you do not have Connector for IBM FileNet installed on your 

exising LiveCycle installation but will license it on LiveCycle or if you are performing an out-of-place upgrade on a new 

operating system.

IBM FileNet 4.0

If LiveCycle is connecting to IBM FileNet 4.0 Content Engine, you must install the Content Engine Java Client. Use 

the IBM FileNet 4.0 content engine client installer located by default in C:\Program Files\FileNet\CEClient. During 

installation, select only the Java client component on the component selection screen.

For IBM FileNet 4.0 Process Engine settings, copy the pe.jar file from the Process Engine directory to the computer 

that will host LiveCycle. Create the directory C:\FileNetPE\files and copy the pe.jar file there. The Process Engine 

client install directory is now C:\FileNetPE. 

IBM FileNet 4.5

If LiveCycle is connecting to IBM FileNet 4.5 Content Engine, you must install the Content Engine Java Client. Use 

the IBM FileNet 4.5 content engine client installer located by default in C:\Program Files\FileNet\CEClient. During 

installation, select at least one of the components from Application Engine or Process Engine on the component 

selection screen. 

For IBM FileNet 4.5 Process Engine, you must install the IBM FileNet 4.5 Process Engine Client located by default in 

C:\Program Files\FileNet\BPMClient. During installation, select the Other option on the component selection screen. 

IBM FileNet 5.0

If LiveCycle is connecting to IBM FileNet 5.0 Content Engine, you must install the Content Engine Java Client. Use 

the IBM FileNet 5.0 content engine client installer located by default in C:\Program Files\FileNet\CEClient. During 

installation, select at least one of the components from Application Engine or Process Engine on the component 

selection screen.

For IBM FileNet 5.0 Process Engine, you must install the IBM FileNet 5.0 Process Engine Client located by default in 

C:\Program Files\FileNet\BPMClient. During installation, select the Other option on the component selection screen. 

5.3.11 Additional requirement for Adobe LiveCycle Content Services 

(deprecated)

PDF Generator must be installed on the server for Content Services to index Microsoft Office 2007 and 2010 

documents (DOCX, XLSX, and PPTX files).

5.3.12 Additional upgrade requirements for Content Services (deprecated)

If your current LiveCycle environment includes a DB2 database and you are installing Content Services with your 

upgrade, you must create and run the following script before you perform your installation.
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5.3.12.1 Prepare for installing Content Services with your upgrade

1 In a text editor, copy the following script:

Note: The following text contains formatting characters for line breaks. If you copy this text to a location outside this 

document, remove the formatting characters when you paste it to the new location.

For DB2 9.1

connect to dbname;  
CREATE BUFFERPOOL BP32K SIZE 4000 PAGESIZE 32768 NOT EXTENDED STORAGE;  
CREATE TEMPORARY TABLESPACE dbname_TEMP_32K IN DATABASE PARTITION GROUP IBMTEMPGROUP 
PAGESIZE 32768 MANAGED BY SYSTEM USING ('DB2_root\dbname32k_TEMP') EXTENTSIZE 32 
PREFETCHSIZE 16 BUFFERPOOL BP32K;  
CREATE REGULAR TABLESPACE dbname_DATA_32K IN DATABASE PARTITION GROUP IBMDEFAULTGROUP 
PAGESIZE 32768 MANAGED BY DATABASE USING (FILE'DB2_root\dbname32k_DATA'9000) EXTENTSIZE 16 
PREFETCHSIZE 16 BUFFERPOOL BP32K;  
commit work;  
deactivate database dbname;  
activate database dbname; 

For DB2 9.5

connect to dbname;  
CREATE BUFFERPOOL BP32K SIZE 500 PAGESIZE 32768;  
CREATE TEMPORARY TABLESPACE dbname_TEMP_32K IN DATABASE PARTITION GROUP IBMTEMPGROUP 
PAGESIZE 32768 MANAGED BY SYSTEM USING 'DB2_root\dbname32k_TEMP') EXTENTSIZE 32 PREFETCHSIZE 
16 BUFFERPOOL  
BP32K;  
CREATE REGULAR TABLESPACE dbname_DATA_32K IN DATABASE PARTITION GROUP IBMDEFAULTGROUP 
PAGESIZE 32768 MANAGED BY DATABASE USING (FILE'DB2_root\dbname32k_DATA'9000) EXTENTSIZE 16 
PREFETCHSIZE 16 BUFFERPOOL BP32K;  
commit work;  
deactivate database dbname;  
activate database dbname;

2 Make the following changes to the script:

• Replace the instances of dbname with the name of your LiveCycle database.

• Replace DB2_root with the path to the root directory where DB2 is installed.

• Ensure that no commands include line breaks and each command is terminated by a semicolon (;).

• Change 9000 in the following line based on your database size:

FILE'DB2_root\dbname32k_DATA'9000

This number specifies the minimum number of pages that is required to initialize the database. You can also change 

this number by using the DB2 administration tools after you initialize the database.

3 Save the text file in a location that DB2 Command Line Processor can access.

4 Open a DB2 command prompt and type the following command to run the script:

db2 -tf <path_to_script_file>/<script_file_name>

5.4 LDAP configuration

This configuration is optional and required only if you are using an LDAP directory to authenticate users.
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When you upgrade LiveCycle Rights Management, LDAP configuration settings are automatically migrated. 

If you do not have an existing LDAP server and database, install and configure your LDAP server and database 

according to the vendor’s documentation. Make note of the LDAP administrator name and password to use during 

the LiveCycle configuration process. Configure LiveCycle to connect with the LDAP database after you install and 

deploy your services that are part of LiveCycle. This configuration is done by using the User Manager service. 

See the Upgrading to LiveCycle document for your application server.

5.5 Global document storage directory

Note: Tasks in this section are required only if you are changing the location of your GDS directory on the system you 

plan to upgrade to LiveCycle.

The global document storage (GDS) directory is used to store long-lived files that are used within a process as well as 

critical LiveCycle product components. The lifetime of long-lived files is intended to span multiple restarts of a 

LiveCycle system, and can span days and even years. These files may include PDF files, policies, or form templates.

Long-lived files are a critical part of the overall state of many LiveCycle deployments. If some or all long-lived 

documents are lost or corrupted, the existing LiveCycle server may become unstable and unusable for an upgrade. 

Input documents for asynchronous job invocation are also stored in the GDS directory and must be available in order 

to process requests.

You must create the GDS directory before you initialize the LiveCycle database. See “5.5.1 Location of the global 

document storage directory” on page 33 for information.

You can reuse the existing GDS directory or copy it’s contents to a new location.

5.5.1 Location of the global document storage directory

You configure the location of your GDS directory with Configuration Manager after you install LiveCycle. The GDS 

directory you specify should be highly available and should have low access time to enhance performance. If the GDS 

directory is on a shared network drive, it is recommended that you specify the location as \\computer_name\GDS.

If you changed the GDS location while installing LiveCycle, you can determine the location of the directory as follows:

1 Log in to LiveCycle Administration Console and click Settings > Core System Settings > Configurations.

2 Note the location that is specified in the Global Document Storage Directory box.

If you must change the GDS directory location after completing the installation (see LiveCycle Administration Help), 

you should plan an appropriate location for the GDS directory. 

Important: Module deployment will fail on Windows if the GDS directory is at the drive root (for example, D:\). For GDS, 

you must make sure that the directory is not located at the root of the drive but is located in a subdirectory. For example, 

the directory should be D:\GDS and not simply D:\.

5.5.2 Sizing factors for the global document storage directory

The size of the global document storage directory depends on expected LiveCycle usage factors for the deployment. 

You should allocate a minimum of 10 GB of disk space for the GDS directory. 

While upgrading to LiveCycle from a previous version of LiveCycle, you must factor in the existing GDS data while 

allocating space for the GDS directory. This actual size required for the GDS directory may be in excess of 10 GB.

http://www.adobe.com/go/learn_lc_upgrade_10
http://www.adobe.com/go/learn_lc_admin_10
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The following factors also affect the sizing:

• The typical volume of documents that LiveCycle processes. Processing high volumes of documents requires a larger 

GDS directory.

• The typical size of documents that LiveCycle processes. Processing large documents requires a larger shared GDS 

directory.

• The complexity of documents that LiveCycle processes. Processing complex documents, such as documents that 

are processed by multiple services that are part of LiveCycle, require a larger GDS directory. 

5.5.3 Securing the global document storage directory

Access to the GDS directory must be secure. The long-lived documents in this directory may contain sensitive user 

information, such as information that requires special credentials when accessed by using the LiveCycle SDK or user 

interfaces.

Use a security method that is appropriate to your operating system. It is recommended that only the operating system 

account that is used to run the application server has read and write access to this directory.

Note: Deleting files or directories from the GDS directory can render the LiveCycle server inoperative. 

5.5.4 Backing up the global document storage directory

The global document storage directory should be backed up to allow administrators to restore LiveCycle in case of 

failure. 

If the global document storage directory becomes unavailable or is lost due to failure, LiveCycle will not run until the 

GDS directory and database are restored by a consistent back up or LiveCycle is reinitialized with a new installation.

5.6 Installation considerations

5.6.1 Disabling Virus scans (Windows only)

To improve the speed of the installation, you may choose to disable any on-access virus scanning software for the 

duration of the installation.

5.6.2 Installing from network drives

It is recommended that you install LiveCycle only from the installation media or a local disk drive. Attempting to 

install the software over a network results in considerable delays in starting and installing. It is also likely that installing 

from a network drive will add to the length of the directory path, which will cause the LiveCycle installer to prevent 

the installation from proceeding. 

5.6.3 Manual use of Acrobat restricted

If you installed the PDF Generator  for native document conversion, use of the bundled Acrobat installation is 

restricted to the Generate PDF service and is not licensed for any other use.
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5.6.4 Temporary directory

LiveCycle requires a temporary directory to store documents that are larger than the maximum inline size set for 

document objects. For detailed information on how you can improve the performance of your LiveCycle Server by 

specifying an appropriate value for this setting, see this blog on the Document Max Inline Size performance knob.

(AIX, Linux, and Solaris only) If a non-root user is running the application server, the user must have read, write, and 

execute permissions on the specified temporary directory.

Important: (For cluster deployments only) Future upgrades might fail if you specify a shared network directory as the 

temporary directory.

5.7 LiveCycle IPv6 support

LiveCycle includes IPv6 support. The default configurations defined in the installation documentation for LiveCycle 

set IPv4 as the default IP protocol because this protocol has the most compatibility with third-party infrastructure. 

Do not enable IPv6 unless your deployment must use it. The number of supported platform configurations is reduced 

when enabling IPv6 support with LiveCycle. You should verify that all third-party software, hardware, and networks 

that you plan to use have IPv6 support before you attempt to enable IPv6.

Note: If you are enabling CIFS in an IPv6 environment, you must explicitly enable IPv6 configuration after you configure 

your LiveCycle installation using Configuration Manager. See “Enabling CIFS in IPv6 mode” in the guide for your 

application server.

5.7.1 Supported IPv6 configurations

Not all infrastructure components support IPv6. For example, Oracle database does not support IPv6. You can use 

these databases by configuring the connection between the application server and the databases with IPv4, and the 

remaining communications over IPv6. 

• Databases that support IPv6: Microsoft SQL Server 2005 and 2008, DB2 9.1 or later versions of 9.x

• Application servers that support IPv6: JBoss 5.1.0, Weblogic 11g, WebSphere 7.0.0.15.

5.7.2 IPv6 implementation guidelines

When you use IPv6 implementation either partially or fully, keep the following points in mind:

• After installing LiveCycle, do not use the option to start the Configuration Manager directly from the LiveCycle 

installer. Instead, navigate to the [LiveCycle root]\configurationManager\bin\IPv6 directory, and run the IPv6-

specific script (ConfigurationManager_IPv6.bat or ConfigurationManager_IPv6.sh) to launch the 

Configuration Manager.

• If you have chosen to validate the application server configuration using the Configuration Manager, the validation 

will fail after you enable IPv6 for the application server. You can ignore this error message during the process. After 

you restart the application server in the IPv6 mode, the application server can connect to the database.

• (WebLogic only) You need to enable IPv6 for the managed servers only. The Admin Server can continue to run on 

IPv4, and can be accessed with its IPv4 address. However, the managed server that you have started in IPv6 

environment can only be accessed through its IPv6 address or a hostname resolved through DNS.

• (WebLogic only) Even if you are running Configuration Manager on the same computer that hosts the application 

server, you must provide the listen address of the managed server for bootstrapping and deploying LiveCycle 

modules. This listen address must be the DNS name that resolves to IPv6 address of the computer.

http://blogs.adobe.com/livecycle/?p=126
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• To have a pure IPv6 communication with the database server, modify both EDC_DS and IDP_DS connection 

settings to use the hostname of the database which resolves to a numeric IPv6 address. 

• Many software components such as database drivers do not completely support numeric IPv6 addresses. So, it is 

recommended that you use a DNS-resolved hostname instead of numeric IPv6 addresses.

• Ensure that name used for mapping IPv6 is added to the CSRF filter section. If the name is not added, see 

Preventing CSRF attacks in Administration Help.

Note: Name used for mapping IPv6 must not contain square brackets ([]).

• In an IPv6 environment, if you are using Microsoft SQL Server, you should specify the database server IP address 

in the following format. Note that in this string, ;serverName is a keyword, and so must not be replaced with the 

actual server name.

jdbc:sqlserver://;serverName=<IPv6 address>; portNumber=<port>;databaseName=<db_name>

Here, instead of the numeric IPv6 address, you can specify the hostname of the SQL Server database.

5.7.3 Configuring IPv6 for JBoss

1 You can download and install JBoss from http://www.jboss.org/jbossas/downloads/ or obtain the jboss.zip file from 

the third-party directory on the installation media and extract the bundled JBoss.

2 Modify adobe-ds.xml and the database-specific data source configuration file to connect to the LiveCycle database.

3 Modify the login-config.xml file to connect to the LiveCycle database.

4 Modify the following files to enable IPv6: 

• (JBoss 5.1 on Windows) [appserver root]\bin\run.conf.bat

(JBoss 5.1 on other platforms) [appserver root]\bin\run.conf

(JBoss 4.2.1 on Windows) [appserver root]\bin\run.bat

(JBoss 4.2.1 on other platforms) [appserver root]\bin\run.sh

Do the following in this file:

• Change -Djava.net.preferIPv4Stack=true to -Djava.net.preferIPv6Stack=true

• Add the -Djava.net.preferIPv6Addresses=true argument.

• [appserver root]\bin\service.bat: Replace - b 0.0.0.0 with -b <hostname mapped to IPv6 address>

5 Launch Configuration Manager by invoking the [LiveCycle root]\configurationManager\bin\IPv6\ 

ConfigurationManager_IPv6.bat or ConfigurationManager_IPv6.sh script.

6 In the Configuration Manager, select the steps to configure EAR files, bootstrap and deploy LiveCycle modules.

7 After the Configuration Manager process is completed, copy these EAR files to the [appserver 

root]\server\<profile_name>\deploy directory.

8 Start JBoss from a command line.

9  Provide Configuration Manager hostname of the computer that is mapped to its IPv6 address and then bootstrap 

the application server to deploy the LiveCycle modules. 

5.7.4 Configuring IPv6 for WebLogic

1 Install LiveCycle using the installer. 

http://www.adobe.com/go/learn_lc_admin_10
http://www.jboss.org/jbossas/downloads/
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2 Do not launch the Configuration Manager when the installer finishes. Launch Configuration Manager by invoking 

the [LiveCycle root]\configurationManager\bin\IPv6\ConfigurationManager_IPv6.bat or 

ConfigurationManager_IPv6.sh script.

3 Select the options to configure LiveCycle EARs, WebLogic application server, and verify the application server 

settings using Configuration Manager. 

Note: You will get an error message that the Configuration Manager validation of data source has failed. This is because 

the application server is not yet started in the IPv6 mode, and the data source is now configured in the IPv6 mode. You 

can ignore this warning at this stage.

1 From the WebLogic Server Administration Console, change the application Server Start arguments of the 

managed server to enable IPv6. 

• Change -Djava.net.preferIPv4Stack=true to -Djava.net.preferIPv6Stack=true.

• Add the -Djava.net.preferIPv6Addresses=true argument.

2 Change the listen address of the managed server to enable it using IPv6 address.

• In the WebLogic Server Administration Console, select Environment > Servers > [managed server 
name]Configuration tab.

• In the Listen Address field, enter the hostname of the computer. Ensure that this hostname resolves to the IPv6 

address of this computer. 

3 Save the changes, and then restart the managed server. 

4 Launch Configuration Manager by invoking the [LiveCycle 

root]\configurationManager\bin\IPv6\ConfigurationManager_IPv6.bat or ConfigurationManager_IPv6.sh script.

5 In the Configuration Manager, select the steps to deploy EAR files, bootstrap, deploy LiveCycle modules. 

6 Enter the same hostname as provided in the listen address field of the managed server.

Note: Even if you are running Configuration Manager on the same computer, you must provide the listen address of the 

managed server for bootstrapping and deploying LiveCycle modules.

5.7.5 Configuring IPv6 for WebSphere

1 Install LiveCycle using the installer script. After the installation is complete, do not start the Configuration Manager 

when the installer prompts.

2 Navigate to the [LiveCycle root]\configurationManager\bin\IPv6 directory, and run the IPv6-specific script 

(ConfigurationManager_IPv6.bat or ConfigurationManager_IPv6.sh) to launch LCM.

3 Use the Configuration Manager options to configure EAR and the application server.

4 Follow the steps in the Configuration Manager to configure the application server. While configuring database, 

provide hostname of database that is mapped to IPv6 address. 

5 Validate the application server configuration by Configuration Manager. Ignore the warning if data source 

validation fails. You can validate data sources from WebSphere Administrative Console.

6 On the WebSphere Administrative Console, select Servers > Server Types > WebSphere application servers > 

[server name] > Java and Process Management > Process definition > Java Virtual Machine. In Generic JVM 

arguments, add the -Djava.net.preferIPv6Addresses=true argument.

7 Select Servers > Server Types > WebSphere application servers > [server name] > Java and Process Management 

> Process definition > Java Virtual Machine, and click Custom Properties. Change 

java.net.preferIPv4Stack=true to java.net.preferIPv6Stack=true.
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8 Manually deploy the EAR files to WebSphere Application Server by using WebSphere Administrative Console. 

Configured EAR files are available at [LiveCycle root]/configurationManager/export folder.

9 Restart WebSphere Application Server.

10 Navigate to the [LiveCycle root]\configurationManager\bin\IPv6 directory, and run 

ConfigurationManager_IPv6.bat or ConfigurationManager_IPv6.sh to launch Configuration Manager.

11 In the Configuration Manager, select the options to bootstrap and deploy LiveCycle modules. Provide the 

application server hostname that is mapped to IPv6 address. 

Note: After you start the application server in an IPv6 environment, (with the flag -

Djava.net.preferIPv6Stack=true), you can access it only through its IPv6 address or hostname mapped to IPv6 

address.

5.8 Server configuration for enabling CIFS

To enable file access to Content Services as a network folder for Windows clients of LiveCycle, you need to enable 

Common Internet File System (CIFS) in Content Services. 

Note: If you are enabling CIFS in an IPv6 environment, you must explicitly enable IPv6 configuration after you configure 

your LiveCycle installation using Configuration Manager. See “Enabling CIFS in IPv6 mode” in the guide for your 

application server.

5.8.1 Creating a virtual interface (AIX, Linux, and Solaris only)

If you want to enable CIFS on LiveCycle deployed on AIX, Linux, or Solaris platform, you must create a virtual 

interface and assign it an IP address on the server that runs LiveCycle. This is required because the CIFS protocol uses 

the same ports that are used by Samba service on AIX, Linux, or Solaris computers. You specify this virtual IP address 

as the alternate IP address when you enable CIFS using the Configuration Manager.

If your LiveCycle implementation is on IPv6, you should create virtual IPv6 interfaces on the CIFS server. The 

interfaces that you create should be within the same network as the CIFS clients. See the documentation related to your 

operating system for more information. 

Note: You should add the virtual interface that you create to the /etc/hosts file to make them persist across reboots.

5.8.2 Configuring Windows Server for CIFS

You will need to manually configure the Windows Server 2003 and 2008 computers that host LiveCycle to enable CIFS 

on them. When CIFS is enabled, users can access the Content Services repository as a network folder and perform 

various file operations on their local file system. In Content Services, CIFS is supported for enterprise domain users 

with ActiveDirectory as their directory provider. 

Note: Ensure that the CIFS server has a static IP address for Java-based CIFS implementation. For Windows native 

implementation, a static IP address is not required.

Note: The user who has enabled remember password would be able to log in to the repository even after his Contentspace 

role is revoked.
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5.8.2.1 Enable NetBIOS over TCP/IP

You need to enable NetBIOS over TCP/IP so that clients connecting to the LiveCycle Server can have their requests 

resolved for the server host name.

1 In the Local Area Connection Properties dialog box, on the General tab, select Internet Protocol, and then click 

Properties.

2 In the General tab of the Internet Protocol (TCP/IP) Properties dialog box, ensure that the server has a static IP 

address. Click Advanced.

3 In the Advanced TCP/IP Settings dialog box, select the WINS tab and select Enable NetBIOS over TCP/IP.

5.8.2.2 Add additional IP address

Note: This step is required only for Java-based CIFS implementation.

1 In the Local Area Connection Properties dialog box, on the General tab, select Internet Protocol, and then click 

Properties.

2 In the General tab of the Internet Protocol (TCP/IP) Properties dialog box, ensure that the server has a static IP 

address. Click Advanced.

3 In the Advanced TCP/IP Settings dialog box, select the IP Settings tab and click Add.

4 Specify a static IP address and click Add.

5.8.2.3 Disable SMB over NetBIOS registry (Windows 2003 only)

You must disable SMB over NetBIOS by editing the Windows registry. 

1 In the Windows Registry Editor, navigate to HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > 

Services > NetBT > Parameters.

2 Set the DWORD SMBDeviceEnabled to 0. If it is not present, add a new DWORD value with name 

SMBDeviceEnabled and set it to 0. 

5.8.2.4 Disable File and Printer Sharing (Windows Server 2008 only)

Important: After you disable file and printer sharing with this step, you will not be able to access the server directly using 

Windows file sharing protocol. This computer will not display in the Windows network view. 

• Go to Network Settings and deselect File and Printer Sharing for Microsoft Clients and click Apply.

For additional settings to enable CIFS on Windows Server 2008, see this article.

5.9 Upgrade: Processes with document form variables 
and digital signatures

If you are upgrading from a previous version of LiveCycle and changing your LiveCycle Server, you may disrupt any 

processes that use the document form variable or digital signatures. This is because these forms are rendered only once, 

setting the submit URL. Changing the server breaks the certificate.

Choose the solution that is most appropriate for your LiveCycle environment from the following solutions:

http://wiki.alfresco.com/wiki/File_Server_Subsystem#Turning_off_windows_native_SMB_.28port_445.29_on_Vista_And_Windows_2008
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Solution 1: Complete all processes that use a form document variable before you upgrade or move to the remote 

server. Use this method if you maintain legacy LiveCycle servers after the upgrade. This approach also eliminates the 

need for throw-away work to be done to manage the redirection of the form submissions. This method is not practical 

if you have many outstanding processes.

Solution 2: If the server being upgraded is not being decommissioned, a reverse proxy approach is preferable. With 

this method, you maintain the reverse proxy on the old system until all the migrated processes are completed.

Solution 3: You can use the Apache mod_rewrite module to modify the embedded URLs in each form as they are 

delivered to the client.

Note: If your LiveCycle implementation is on IPv6, clients using EJB invocation for PDF creation report exceptions. This 

is a known issue attributed to Sun JDK 6. 

5.10 Central Migration Bridge service

The Central Migration Bridge service helps you to migrate existing applications from your Adobe Central Pro Output 

Server or Adobe Web Output Pak products to work with the Output service. The Central Migration Bridge service 

allows you to use your current IFD/MDF templates, data transformation scripts, and DAT files in a LiveCycle 

environment as part of an overall migration strategy.

Note: The Central Migration Bridge is useful only if you have existing Central Pro applications to migrate.

Authorized use of Central Migration Bridge

To use the Central Migration Bridge service, you must have a valid license for Central Pro Output Server 5.7 or an 

executed Central Pro Output Server 5.7 migration agreement. To install Central Pro Output Server 5.7, use your 

existing media and existing product authorization code (PAC). Your PAC is for a specific operating system platform; 

if this differs from the operating system platform on which you are installing LiveCycle, you will need to acquire a PAC 

for that operating system. Contact your Adobe representative for more information regarding migration, or acquiring 

Central Pro Output Server 5.7 media or PAC.

Installation considerations

The Central Migration Bridge service interacts directly with the Central Pro (version 5.7) executable files. You must 

have Central Pro installed on the same server as LiveCycle, but it is not a prerequisite to installing LiveCycle (that is, 

it can be installed before or after LiveCycle). Consult the Central Pro documentation set for installation instructions.

Important: Do not start Central Pro or change its properties to run automatically. 

On Windows, the Central Pro service Adobe Central Output Server is installed as a manual service. Do not run the 

service or change its properties to run automatically. 

On AIX, Linux, or Solaris, do not start the Central Pro daemon jfdaemon. If you edited the start-up script of your 

computer to launch jfdaemon when restarting the computer, change the script to prevent the daemon from being 

launched automatically. (See the Central Pro installation documentation.) Do not start Central from the command 

line by launching the jfserver process. 

Note: The LiveCycle User that invokes the Central Migration Bridge service must have access rights to the Central Pro 

install directory as well as execute permissions on the Central Pro executable files.

LiveCycle turnkey installations

If you are installing and configuring a LiveCycle turnkey environment using Express mode, the Central Migration 

Bridge service will be installed and configured by default - you will not be prompted for any input. 

http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=6230761
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Note: Ensure that the Adobe Central Pro product is installed in the default directory.

LiveCycle custom installations

If you are installing and configuring LiveCycle using the Custom mode (Partial turnkey or Manual), Configuration 

Manager will prompt you to include Central Migration Bridge in the deployment.

By default, the service will use the default Central Pro installation path. If Central Pro is installed in a different location, 

update the [Central Install Dir] configuration for the Central Migration Bridge Service by going to Administration 

Console.

When you have finished installing LiveCycle, if Central Pro is not installed in the default location, do the following 

steps to point LiveCycle to the correct directory:

1 Log in to Administration Console.

2 Click Services > Applications and Services > Service Management.

3 Click the Central Migration Bridge:1.0 service.

4 Type the correct path to the Central Pro install directory.

5 Click Save.

Note: This configuration can also be made in Workbench. See Creating and managing processes.
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